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MIPC (Mobile Imaging and Printing Consortium)

The MIPC is a non-profit industry association founded in 2004 by leading companies in photo 
printing and the mobile phone industry. Its mission is to promote and support the 
development of interoperability guidelines enabling printing of images and other content 
between mobile phones and printing devices. The guidelines are promoted for use 
internationally to ensure a broad spectrum of products and services for mobile phone 
consumers. http://www.mobileprinting.org

MY_WAY plus: This Mobile Printing Ready product is designed to provide easy printing from 
mobile phones. This product follows Mobile Imaging and Printing Consortium (MIPC) 
Implementation Guidelines for Printing with Mobile Terminals, Version 1.0, for: Bluetooth, 
PictBridge, Memory Card.
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OVERVIEW

This product carries out the functions of a high quality ink-jet portable printer and is characterized by 
reduced weight and wireless operating mode.
The printer is fitted with a 3-color head for high quality printing of photographs on photographic paper 
or plain paper without borders.
The printer can be powered with rechargeable batteries and is equipped with a Bluetooth interface for 
wireless connection from a mobile phone, to become an inseparable companion during your leisure 
time.

It can be used in the handy PC-free or stand-alone mode in which it is possible to print 10x15 cm 
(4”x6”) format photographs simply connecting a PictBridge-compatible, DPOF or non PictBridge/DPOF 
digital camera to the USB interface, without having to connect the printer to a computer and therefore 
without having to switch on the PC. It is also possible to insert memory cards in the related slots on the 
side panel of the printer for selection and printing of the photos saved.
Photographs can be printed directly from a mobile phone via wireless technology using the Bluetooth 
interface integrated in the printer.

The printer can be connected to a personal computer on the second USB interface.
In this case, as in PC-free mode, the Olivetti Toolbox application can be used for fast access to all 
available capabilities, to use the document management software and the additional software available 
on the "Installation" CD-ROM.
note: If you want to connect the printer to a personal computer, this must use the Microsoft Windows 
98 SE, Me, 2000 or XP operating system, or MAC OS X 10.2 or higher version.

SAFETY INSTRUCTIONS

Carefully read and follow the information indicated below:
• Connect the power cord to an electrical outlet that is near the product and easily accessible.
• Do not use your printer near water or with wet hands.
• Do not expose your printer to rain or moisture.
• Do not attempt to disassemble your printer. 
• Observe all warnings and instructions marked on your printer.
• Read and understand all the documentation that came with your printer.

note: This product works correctly and complies with safety norms when used with the CA power 
supply unit provided by the manufacturer. When using different power sources than those provided in 
the product packaging, it will be the user’s responsibility to guarantee compliance with safety norms 
and with the correct power ratings that this product requires.

INFORMATION ABOUT PRINT QUALITY AND THE WARRANTY

To guarantee the correct operation of your printer and top quality printing, it is essential to use only 
Olivetti original ink cartridges.

Olivetti declines any responsibility for damage to your printer caused by the tampering with, or refilling 
of, the ink-jet cartridges. Such actions also imply forfeiture of the Warranty.
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Reference Part Desccription

1 Control panel Features the colour Liquid Crystal Display (LCD), the power 
button, Bluetooth activity indicator, error LEDs and a number of 
buttons that allow you to print and customize print jobs and 
indicators that signal out of ink and out of paper conditions. See 
"Printer Control Panel" for a description of the functions 
available.

2 USB interface Plug the USB cable from your digital camera to print photographs 
directly from your camera.

3 Power connector Connector into which you plug the printer’s external AC power 
supply unit or car lighter AC adapter, both of which provided in 
the product packaging. 
note: Plug the external AC power supply unit into the printer first 
and then into the electrical outlet.

4 Carry handle Extract this handle to carry your printer wherever you go.

5 High-speed USB 
interface

Plug the USB cable (not included) used for connection to your 
personal computer. Plug the other end of the cable to the 
computer.

6 Paper cassette 
insertion slot

Insert here the paper cassette after sliding it off the rails on the 
bottom of your printer.

7 Memory card slots Insert your memory cards in these slots to read their contents and 
select the pictures that you want to print. See "Inserting and 
Removing Memory Cards". Can accommodate Compact Flash I, 
II, Microdrive, SmartMedia, SecurDigital and MultiMedia cards, 
Memory Sticks and xD-Picture cards.

8 Ink cartridge carrier Holds the colour ink cartridge. For information on how to change 
the ink cartridge, see "Replacing the Ink Cartridge".

9 Paper exit slot and 
paper jam clearing 
area

Slot from where the printed sheet of paper exits the printer. Also 
used for clearing paper jams inside the printer. For information on 
how to clear paper jams, see "Clearing Paper Jams".

10 Right inner door Closes the paper exit slot and ink cartridge carrier. Opening this 
door during a print job will interrupt the printing underway.

11 Battery compartment Holds six rechargeable AA size 1.2 V Nickel Metal Hydride (NiMH) 
batteries, with a capacity of at least 2.2 to 2.5 Ah each, that 
power the printer when the external AC power supply unit or car 
lighter DC adapter is not used.
note: The batteries must be fully charged when inserted in the 
printer. Make sure that you also have an appropriate battery 
charger (sold separately) so that you can recharge the batteries 
when they are discharged.

12 Paper cassette Holds up to 20 sheets of 280 gm2 photo paper. When not used, 
the paper cassette can be secured underneath the printer.
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PRINTER CONTROL PANEL 

The control panel of the printer makes it possible to set printing of photos received from a digital 
camera connected to the printer, saved on the memory card inserted in the specific slot of the printer or 
received via a Bluetooth peripheral. The colour display can be used to scroll and display the photos.
The panel includes various buttons that are used to select the photos required and to personalise 
printing of these. The icons on the buttons light up to indicate currently active functions.

on

cancel

select

printlayout

copies

view

magic

4
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12

Reference Part Desccription

1 On/Off button Used to switch the printer ON and OFF.

2 Ink out indicator Flashes or lights up to indicate that the ink cartridge is running 
out; in this case, it is advisable to replace the cartridge. 
See "Replacing of the ink cartridge".

3 Paper error indicator • Lights up to indicate that the paper is out.
• Lights up to indicate jamming of the paper.
• Lights up to indicate feeding of an incorrect paper format 

during printing.

4 Magic button Press to improve the quality of all the photos that you have 
selected for printing. The new image generated is not displayed 
on the display or saved but is available for printing.

5 Cancel button Permits immediate cancellation of current printing, causing 
ejection of the paper and restore of the default settings.

6 Selection button Press this button to select the photo displayed on the LCD.

7 Print button Press this button to print the photos selected. This button flashes 
during printing. 
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8 Page layout button Press to select the layout with which the photos are to be printed 
on paper. Press this button sequentially to select:
• 1 borderless photo adapted to the format of the sheeto 
• 1 photo with borders adapted to the format of the sheeto 
• 2 borderless photos adapted to the format of the sheeto 
• 4 borderless photos adapted to the format of the sheeto the 

index of your images will be printed correctly if already 
compiled by the peripheral (digital camera). If the image index 
is not provided by the peripheral, the printer will create its 
own index which may not be complete.

Only the icon selected remains ON.

9 Number of copies 
button

• Press the button with the (+) sign to increase the number of 
copies to be made (max. 9).

• Press the button with the (-) sign to reduce the number of 
copies to be made (min. 1).

The number selected is displayed in the bottom right-hand corner 
of the image selected.

10 Navigation button Makes it possible to move between the images displayed, shifting 
a white highlight frame. Hold the button down for automatic 
scrolling from one image to another.

11 Display button Press this button to switch from full screen display to index (3x3 
images).

12 Colour display 2.4" LCD display for preview and selection of the images.
Active Display
The bar of the icons which highlights the total number of images 
selected for printing to the right and the icon that represents the 
device connected to the left is present in the lower part of the 
display.

13 Bluetooth activity 
indicator

Switches on at printer power-on if the Bluetooth function is 
enabled.
Flashes during file transfer from a Bluetooth peripheral to the 
printer.

Reference Part Desccription
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LOADING PAPER

The printer is equipped with a paper detection sensor that automatically detects whether the paper is 
fed manually or from the paper cassette.

Loading Paper in the Paper Cassette

1 Open the paper cassette lid. Load up to 20 sheets of photo paper in the paper cassette bay with the 
print or glossy side facing upward, adjusting the paper width guide accordingly. Close the paper 
cassette lid.

2 Open the printer’s left outer door by pressing the upper centre part of the door to release it. Insert the 
paper cassette into the insertion slot and press it firmly until it clicks into place.

Loading a Single Sheet of Plain A4 Paper Folded Vertically in the Middle

You can manually load a single sheet of A4 plain paper folded vertically, corresponding to a double A6 
size format (105 x 297 mm). 

1 Make sure that your printer is turned on and that the paper cassette is inserted. See “Turning On Your 
Printer”.

2 Fold a sheet of plain A4 size paper vertically in the middle. Place the paper between the two paper 
guides on the top of the paper cassette and feed the leading edge of the sheet into the insertion slot 
until it is picked up by the printer’s feed mechanism.
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POWERING YOUR PRINTER

Choosing the Power Source For Your Printer

You can power your printer from the mains electrical power supply by using the external AC power 
supply unit provided, from your automobile battery by using the car lighter DC adapter provided, or 
with six rechargeable AA size 1.2 V Nickel Metal Hydride (NiMH) batteries, with a capacity of at least 
2.2 to 2.5 Ah each, that you can purchase from electronic stores or from large retailers. The batteries 
must be fully charged when inserted in the printer. 
note: The printer will not charge your rechargeable batteries. You can order an Olivetti battery charger 
kit by phoning a hot-line number listed in the leaflet that came with the printer, provided in the printer 
software or in the Olivetti web site.

Mains Electrical Power Supply
1 Insert the external AC power supply unit cable jack into the printer’s power socket, then insert one end 

of the power cord into the power supply unit and the other end to an electrical wall outlet.

12V Car Battery DC Power Supply
1 Plug one end of the car lighter DC adapter into the printer power socket and the other end into your 

automobile’s cigarette lighter.
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Rechargeable NiMH Batteries
1 Turn over your printer and then open and remove the battery compartment cover.
2 Insert six rechargeable AA size 1.2 V Nickel Metal Hydride (NiMH) batteries, with a capacity of at least 

2.2 to 2.5 Ah each, in the battery compartment then replace and close the compartment cover. 
The batteries must be fully charged when inserted in the printer.

TURNING YOUR PRINTER ON AND OFF

Turning On Your Printer

Press the ON/OFF button on the printer control panel.  
The printer will execute a series of autodiagnostic tests aimed at detecting any possible system 
malfunction. Any error detected at this time will be signalled by the control panel, or by the personal 
computer if connected to the printer.

When you connect a non-PictBridge digital camera to the printer or insert a memory card in the 
appropriate memory card slot, all of the icons on the control panel will illuminate. When you connect a 
PictBridge-compliant digital camera only the Print button will turn off to indicate that printing is 
controlled directly from the attached digital camera.

Turning Off Your Printer

To turn off your printer when you finished working with it, press the ON/OFF button on the control 
panel. All the lights on the control panel, and the LCD, will turn off.
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CONNECTING A DIGITAL CAMERA TO YOUR PRINTER

1 Turn on your digital camera. Read your camera’s User’s Guide for more information.
2 With your printer powered on, plug one end of the digital camera’s USB cable to the USB connector on 

the camera.
3 Open the printer’s left outer door by pressing the upper centre part of the door to release it. Plug the 

other end of the USB cable into the printer’s USB connector.
When you connect a PictBridge-compliant digital camera to your printer, the print icon on the control 
panel will turn off to indicate that printing will be controlled directly from the digital camera. Read your 
camera’s User’s Guide for instructions on how to print your photos.

INSERTING AND REMOVING MEMORY CARDS

Your printer can read the following memory storage devices: Compact Flash I, II, Microdrive, 
SmartMedia, SecurDigital and MultiMedia cards, Memory Sticks (Duo, Pro, Magic Gate) and xD-Picture 
cards.
note: Adaptors for reading Mini SD and MS Pro memory cards can be purchased separately.
Your printer can recognize and print the following file formats stored on the memory cards: DCF, JPEG, 
Extif and DPOF.

Inserting a Memory Card

• When inserting a CompactFlash card, make sure that the label is facing upward (if the label has an 
arrow it needs to be pointing towards the printer) with the metal pinholes entering the printer first. 

• When inserting a Multimedia and SecureDigital cards, make sure that the angled corner is on the 
right and the metal contacts are facing downward.

• When inserting a SmartMedia card or a Memory Stick, make sure that the angled corner is on the 
right and the metal contacts are facing upward.

• When inserting a xD-Picture Card, make sure the curved side of the card is facing you and the metal 
contacts are facing downward.
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Proceed as follows:
1 Open the printer’s left outer door by pressing the upper centre part of the door to release it, so you can 

access the memory card slots. 
2 Orient your specific memory card as indicated at the beginning of this section, carefully insert it into the 

selected slot and then gently push it in until it stops. 
The following figure shows an example of the insertion of a Compact Flash card.
note: The memory card does not go in all the way; do not try to force it in since doing so will damage 
the card and the printer.

If the card is inserted correctly, an icon is displayed on the LCD indicating the total number of photos 
stored on the memory card (only the compatible files are opened and counted).

Removing a Memory Card

1 Carefully pull the card completely out of its slot. To remove a Compact flash card, push the extraction 
button located on the side of the insertion slot.
CAUTION: DO NOT remove the memory card while it is still being accessed either by the printer or 

personal computer. Doing so could damage the photos stored on the card.
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 CARRYING YOUR PRINTER

1 Extract the paper cassette from its insertion slot on the right side of the printer and close the printer’s 
left outer door.

2 Slide the paper cassette along the cassette rails on the bottom of the printer until it is locked in place by 
the securing feature.

3 Extract the handle on the top of the printer and carry the printer wherever you go.

REMOVING THE PAPER CASSETTE FROM THE BOTTOM OF THE PRINTER

1 Turn over your printer.
2 Press the paper cassette securing feature and slide the cassette off the bottom of the printer.  
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PRINT SETTINGS IN BLUETOOTH MODE

Printing on the Bluetooth wireless connection is possible if this capability is integrated in the computer 
or if an external Bluetooth device has been installed (e.g. a Bluetooth USB pen). The Bluetooth function 
must be active on the printer.
The range of the Bluetooth system is usually around 10 meters but may vary according to the 
characteristics of the environment in which it is installed.
The printer supports the Bluetooth 1.2 Class 2 communication system for connection to compatible 
computers and cellphones.
The method of installation varies according to the type of use of the printer.

Activating of Bluetooth

The printer is configured for use of Bluetooth from compatible cellphones and does not require any 
type of installation. 
To verify whether the Bluetooth capability is available, check that the blue LED of the Bluetooth icon is 
ON. If the blue LED of the Bluetooth icon is OFF, proceed as follows:

• In the Windows environment:
1 Carry out USB installation as described in the documentation entitled "Setting up your printer"

note: If installation has already been performed, it is not necessary to repeat it.
2 Open the Toolbox program (Start > Olivetti> Programs> Toolbox).

note: The USB cable must be connected and the printer must be powered on.
3 Click the "Settings" button and then "Bluetooth Settings" to access configuration of Bluetooth 

parameters.
4 Enable Bluetooth mode and click "Send settings": wait for automatic reception of the data of the 

Bluetooth network present: the blue light on the printer lights up.
Close the "Toolbox" program.

5 The printer is not able to operate in the Bluetooth environment. 
If a password is requested in the connection phase, type "0000" (or other if set by the user).

• In the Mac OS X environment:
1 Carry out USB installation as described in the documentation entitled "Setting up your printer".

note: If installation has already been performed, it is not necessary to repeat it.
2 Run the Toolbox program from the desktop.

note: The USB cable must be connected and the printer must be powered on.
3 Click the "Settings" button and then "Bluetooth Settings" to access configuration of Bluetooth 

parameters.
4 Click "Bluetooth Status". Activate the Bluetooth mode and wait for automatic reception of the data 

of the Bluetooth network present: select "Apply".
Close the "Toolbox" program. 

5 The printer is now able to operate in the Bluetooth environment. 
If a password is requested in the connection phase, type "0000" (or other if set by the user).
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VIEWING PHOTOS ON YOUR PRINTER’S DISPLAY

Full-Screen Views

Navigating Through Full-Screen Views and Selecting Photos
1 To scroll through all the photos that are stored on the connected storage device and displayed in this 

screen view, press the Right and Left Navigation button.
2 To select the photo displayed and that you want to print, press the Select button.
3 To deselect the photo displayed, press the Select button again.

Reference Part Description

1 Browse window Displays the current photo.

2 Select frame Indicates the selection state, highlighted when the Select button 
is pressed to select the photo displayed.

3 Image Total field Indicates the number of selected photos that you want to print.

4 Device icon Represents the device connected. 

5 Icon bar The bar where the different icons reside.
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Thumbnail Views

Improving the Photo’s Print Quality

Photo print quality can be improved using the Magic button. 
1 Press the Magic button: the printer analyzes the images and makes the necessary corrections.

note: The results of these operations are not shown on the LCD so as not to alter the original photo: 
the result is visible only during printing.

2 Press the Print button to print the photos modified; hold down the  Magic button selected.

SELECTING AND PRINTING PHOTOS FROM YOUR MEMORY CARD

1 Open the printer’s left outer door by pressing the upper centre part of the door to release it, then insert 
the memory card that you wish to print from into the related slot. The file transfer screen is displayed 
on the LCD indicating that your printer is reading the compatible files stored on the connected memory 
card.

2 A screen indicating the total number of compatible photos stored on the memory card is displayed on 
the control panel LCD. If needed, press the Change View button to toggle between full-screen and 
thumbnail screen views. See "Viewing Photos on Your Printer’s Display". An icon on the screen’s icon 
bar will indicate the device connected.

3 Using the Right, Left, Up, Down Navigation button, scroll through the photos to position the 
highlighted frame on the photo you wish to print.

4 Select the number of copies you want to print of the photos selected by pressing the plus (+) or minus 
(-) button. A copy indicator is displayed on the bottom-right corner of the photo selected to indicate 
the number of copies requested for that photo. The total number of photos selected is displayed on the 
icon bar on the bottom of the screen.

7

Reference Part Description

1 Photo indicator Indicates how many compatible photos are stored on the 
connected device.

2 Select frame Indicates that the photo was selected by using the Select button. 
The number that appears on the bottom corner of the frame 
indicates the number of copies requested. 

3 Browse frame Highlights the current image as a result of the of the pressing of 
the Navigation button.

4 Thumbnail grid A total of 9 grids where the photos are displayed in miniature 
format.

5 Image total field Indicates the number of photos that you want to print.

6 Device icon Indicates the device connected.

7 Icon bar The bar where the different icons reside.
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5 Select the layout in which you wish to print the selected photos by pressing the Page Layout button the 
number of times needed to select the required layout. You have the following possibilities: 
– Print an index sheet of all the photos if "All photos" was selected (by clicking on the icon showing 

the total number of photos stored on the memory card).
– Print 4 borderless photos fitted on the page size.
– Print 2 borderless photos fitted on the page size.
– Print 1 photo with borders and fitted on the page size.
– Print 1 borderless photo fitted on the page size.

6 Open the printer’s right outer door by pressing the upper centre part of the door to release it.
7 Press the Print button to print the selected photos. The illuminated button icons will go off, the photo 

processing screen is displayed on the LCD. 
8 Upon completion of the print job, the initial screen indicating the number of photos stored will be 

redisplayed.

PRINTING PHOTOS FROM YOUR PICTBRIDGE-COMPLIANT DIGITAL CAMERA

1 Load the paper on which you want to print. For optimum results when printing photographs, use 
photo paper. For information see "Loading Paper".
note: If the size of the paper loaded in the printer is different than the paper size selected from the 
digital camera for printing and you begin to print, the printed output will be wrong.
Only a paper size smaller than the size selected from the digital camera will interrupt the print job and 
cause the Print button on the control panel to illuminate. Load the correct paper and press the Print 
button to resume printing.

2 Open the printer’s right outer door by pressing the upper centre part of the door to release it.
3 Make sure your PictBridge-compliant digital camera is turned on and connected to the printer. For 

more information, see "Connecting a Digital Camera to Your Printer".
4 Printing is managed directly by your camera, so read your camera’s User’s Guide for instructions on how 

to print your photos.
During printing, the Print button will flash to indicate that a print job is under way.

SELECTING AND PRINTING PHOTOS FROM YOUR DPOF DIGITAL CAMERA

Your printer is capable of recognizing the DPOF information associated to picture files. In the case of a 
DPOF digital camera, the printer will print the photos that you select directly from your camera. 
note: Before proceeding, make sure that your digital camera is DPOF-complaint by reading the 
camera’s User’s Guide. 

1 Load the paper on which you want to print. For best results when printing photographs, use photo 
paper. For information see "Loading Paper".
note: If the size of the paper loaded in the printer is different than the paper size selected from the 
digital camera for printing and you begin to print, the printed output will be wrong.
Only a paper size smaller than the size selected from the digital camera will interrupt the print job and 
cause the Print button on the control panel to illuminate.
Load the correct paper and press the Print button to resume printing.

2 Open the printer’s right outer door by pressing the upper centre part of the door to release it.
3 Make sure your DPOF digital camera is turned on and connected to the printer. For more information, 

see "Connecting a Digital Camera to Your Printer".
4 If you associated DPOF information to the photo files stored in your camera’s memory, the printer will 

automatically print the photos that you have selected. Read your camera’s User’s Guide for instructions 
on how to select the photos you want to print.

5 If you did not associate DPOF information to the photo files, a screen indicating the total number of 
photos stored in the digital camera’s memory is displayed on the control panel LCD. If needed, press 
the Change View button to toggle between full-screen and thumbnail screen views. See "Viewing 
Photos on the Control Panel LCD" for information regarding the views and indications displayed on the 
LCD. An icon displayed on the screen’s icon bar will indicate the device connected.

6 Using the Right, Left, Up, Down Navigation button, scroll through the photos to position the 
highlighted frame on the photo you wish to print.
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7 Select the number of copies you want to print of the photos selected by pressing the plus (+) or minus 
(-) button. A copy indicator is displayed on the bottom-right corner of the photo selected to indicate 
the number of copies requested for that photo. The total number of photos selected is displayed on the 
icon bar on the bottom of the screen.

8 Select the layout in which you wish to print the selected photos by pressing the Page Layout button the 
number of times needed to select the required layout. You have the following possibilities: 
– Print an index sheet of all the photos if "All photos" was selected (by clicking on the icon showing 

the total number of photos stored on the memory card).
– Print 4 borderless photos fitted on the page size.
– Print 2 borderless photos fitted on the page size.
– Print 1 photo with borders and fitted on the page size.
– Print 1 borderless photo fitted on the page size.

9 Press the Print button on your printer’s control panel to print your photos. For more information see 
“Printer Control Panel”.

SELECTING AND PRINTING PHOTOS FROM YOUR NON-PICTBRIDGE/DPOF DIGITAL CAMERA

1 Load the paper on which you want to print. For optimum results when printing photographs, use 
photo paper. For information see Loading Paper".

2 Open the printer’s right outer door by pressing the upper centre part of the door to release it.
3 Make sure your digital camera is turned on and connected to the printer. For more information, see 

"Connecting a Digital Camera to Your Printer".
4 A screen indicating the total number of photos stored in the digital camera’s memory is displayed on 

the control panel LCD. If needed, press the Change View button to toggle between full-screen and 
thumb-nail screen views. See "Viewing Photos on the Control Panel LCD" for information regarding 
the views and indications displayed on the LCD. An icon displayed on the screen’s icon bar will indicate 
the device connected.

5 Using the Right, Left, Up, Down Navigation button, scroll through the photos to position the 
highlighted frame on the photo you wish to print.

6 Select the number of copies you want to print of the photos selected by pressing the plus (+) or minus 
(-) button. A copy indicator is displayed on the bottom-right corner of the photo selected to indicate 
the number of copies requested for that photo. The total number of photos selected is displayed on the 
icon bar on the bottom of the screen.

7 Select the layout in which you wish to print the selected photos by pressing the Page Layout button the 
number of times needed to select the required layout. You have the following possibilities: 
– Print an index sheet of all the photos if "All photos" was selected (by clicking on the icon showing 

the total number of photos stored on the memory card).
– Print 4 borderless photos fitted on the page size.
– Print 2 borderless photos fitted on the page size.
– Print 1 photo with borders and fitted on the page size.
– Print 1 borderless photo fitted on the page size.

8 Press the Print button on your printer’s control panel. The photos stored in the memory of your camera 
will be printed. 



CHAPTER 220

PRINTING PHOTOS FROM A BLUETOOTH PERIPHERAL

Your printer is equipped with an integrated Class 2 Bluetooth component. 
Its default address is 0000 so it can directly print any .JPEG transmitted from a Bluetooth mobile phone 
located within a maximum distance of 10 meters from the printer.
note: You can change your printer’s default Bluetooth address from your personal computer, if 
connected to the printer.

1 Make sure that paper is loaded in the printer. For information see "Loading Paper".
2 Open the printer’s right outer door by pressing the upper centre part of the door to release it.
3 Turn on your printer. See "Turning On Your Printer". Bluetooth capabilities are automatically activated 

on your printer.
4 Turn on the Bluetooth peripheral that you want to print from and, from within a distance of 10 meters 

from the printer, launch a Bluetooth discovery procedure directly from your peripheral. By activating 
this procedure, your Bluetooth peripheral will search for another Bluetooth device in the vicinity (in this 
case, your printer) with which it can share data. For information on how to launch a Bluetooth 
discovery procedure, read your peripheral’s User’s Guide.

5 When your Bluetooth peripheral has discovered your printer, launch the print job directly from your 
Bluetooth device. For instructions, read your peripheral’s User’s Guide.
The Bluetooth activity indicator on the control panel will flash as the photos are being transferred from 
the Bluetooth device to your printer for printing. The photos will be printed without borders.
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BEFORE YOU BEGIN

This chapter outlines the basic operating information that will put you in the condition to start using 
your printer when connected to a computer. 
Before you begin:

1 Make sure that your printer and personal computer are connected properly and that the software on 
the “Installation" CD-ROM was successfully installed on the computer as indicated in the Installation 
Guide provided with your printer.

2 Load the paper on which you want to print. For more information see “Loading Paper".
3 Make sure that the out of ink indicator on the control panel is not flashing, or not illuminated. If it is, it 

is suggested that you replace the ink cartridge. For more information see “Replacing the Ink 
Cartridge".

4 Bear in mind that the buttons on your control panel are not active when the printer is used from the 
Toolbox installed on your personal computer. Only the Cancel button can be used to interrupt a print 
job underway.

THE TOOLBOX

The Toolbox application allows you to control printing operations directly from a single user interface 
on your computer monitor. 
Included in the “Installation" CD-ROM, the Toolbox is installed automatically on your computer when 
you install the software contained on this CD-ROM. 
To access the Toolbox:

1 Right click your mouse button on the Olivetti icon on the Windows task bar and click on MY_WAY 
Toolbox, or click Start > Programs or All Programs > Olivetti > MY_WAY Toolbox. The Toolbox is 
displayed.
note: In the Mac OS X environment, the Toolbox program can be launched by clicking the icon 
present on the desktop or by selecting it from the list of installed programs.

The main area of the Toolbox includes the icons representing the different tools available. 
 Toolbox icon: You can:

Print photos • Browse the folders of your computer’s hard disk, the memory of the non-
Pictbridge/DPOF digital camera connected to your computer or the memory 
card inserted in your printer to search for the folder containing photos to print.

• Select all the photos stored in the folder or just the individual ones wanted, and 
choose how may copies to print.

• Select the type of paper to print on, and its size.
• Select whether to print the photos on a single page, two on one page or four 

on one page.
• Print an index sheet of photos.
• Print the photos you have selected.

Memory card file 
transfer

• Transfer the contents of the memory card inserted in the printer to a folder on 
your computer. See "Transferring Files from Memory Card to your Computer".
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The Toolbox main interface screen also provides links to Help, Solutions and assistance, and Settings.

THE PRINTER STATUS MONITOR

The Printer Status Monitor provides information on the current state of your printer. It is installed 
permanently on your computer when you install the software contained on the "Installation" CD-ROM. 
Displayed automatically at the beginning of a print job, the Status Monitor:

• displays a graphical representation of the percentage of the print job already completed.
• displays the page number being currently printed out of the total number of pages of the job.
• displays a graphical representation of the estimated amount of ink, in percentage, still available in the 

cartridge.
• allows you to cancel the print job.
• provides you with the address of the manufacturer’s web site, where you can access the information 

needed to purchase new ink cartridges.
The Status Monitor closes automatically at the end of the print job, but you can close it to its icon on 
the Windows task bar at any time.
If you decide to close the Status Monitor during a print job, it will be automatically redisplayed in the 
following conditions:

• when the ink remaining in the cartridge is low, or when the cartridge is out of ink. A coloured 
exclamation mark will indicate when the cartridge in a low ink condition and the importance of the 
condition. Pop-ups will be displayed with the address of the manufacturer’s web site, where you can 
access the information needed to purchase a new ink cartridge.

The Printer Status Monitor also displays error pop-ups when:
• your printer runs out of paper.
• a paper jam has occurred.
• your printer is busy with another task.
• your printer is not recognised.
• the ink cartridge carriage is jammed.
• your printer does not work (printer error).

In all of the above error conditions, you can choose whether to continue or cancel the print job by 
clicking the related button on the screen.

 Toolbox link: You can:

Help • Read more information on the currently displayed topic.

Solutions and 
assistance

• Clean and test the ink cartridge. 
• Automatically align the ink cartridges. See "Aligning the Ink Cartridge From the 

Toolbox".
• Find the address of the manufacturer’s web site, where you can access the 

information needed to purchase new ink cartridges.
• Access troubleshooting information.
• Access contact information.

Settings • Change the Toolbox default settings.
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PRINTING 

Printing From Your Application Using Print Properties

1 With the document or photo open in the application that you are using, click File > Print to open the 
Print dialogue box.

2 Click Preferences or Properties, depending on your operating system. 
3 On the Paper/Quality tab, customise your print settings:

a Document type: define the characteristics of the document that you want to print. Select Auto 
detection to have the printer automatically detect the characteristics of the document or Manual
selection to manually define the characteristics yourself.
If you select Manual selection, choose the characteristics of the document to be printed: Text
(black text or line art only), Mixed (combination of black text or line art and colour graphics or 
photos), or Photo (colour photos only).

b Paper Setup: from the drop-down menus available, select the type of paper that you want to use 
(Plain, Coated, Photo, Glossy, Cards) and its size. 
• If you select Coated or Cards as the type of paper you will be using, the Borderless checkbox is 

displayed so you can choose to print without borders. 
• If you select Photo or Glossy paper as your paper type, by default the Borderless checkbox will 

be selected enabling you to print borderless photos on the selected media.
• If plain paper is selected the Manual Feed checkbox is already selected. In this case the printer 

will not begin to print until you load the paper, and will automatically recognise the size of the 
paper loaded. Plain A4 size paper folded in the middle can be fed only manually from the top of 
the paper cassette.

note: If you load paper that is smaller than the selection made, the printer will eject the paper 
prompting you to load paper corresponding to the selected size.

c Quality: define the quality of your printed output. Select between Speed (highest print speed, 
lowest resolution), Normal (average print speed and resolution), High (low print speed, high 
resolution) and Photo Quality (lowest print speed but with the highest print resolution).
• You can also select to print in Colour or in B/W (Black and white). By default the Colour radio 

button is always checked, enabling full-colour printing. Select B/W when you need to print 
shades of grey, or to continue to print when the colour cartridge is out of ink.

d By default, the Print Last Page First checkbox is selected so upon completion of the print job the 
first page of your multiple-page document remains on top of the document. Click this checkbox to 
deselect it if you want to print starting from the first page of your document. 

e In the No. Copies box, use the up or down arrows to define the number of copies you want to 
print.

f To return the different screen settings to their factory default values, click the Default button.
g On the bottom of the screen:

• Click the OK button con confirm the settings made and exit. 
• Click the Cancel button to exit without saving the changes made. 
• Click the ? button for information on the Paper/Quality tab.

4 Click the Layout tab to select the layout format of your printed output:
a The Single page per print radio button is selected by default. Your printer will print the individual 

pages of the document, or your photos, on a single page layout. 
b Click the Multiple pages per print radio button to fit the selected number of pages on a single 

sheet of paper. By selecting this option:
• The Pages per print drop-down menu is displayed where you can select to print either 2 or 4

pages of your document on a single sheet.
• The Order drop-down menu is then displayed where you can select the order in which the 

multiple pages will be fitted on the single sheet of paper. You can select between Left-to-right 
down, Right-to-left down, Right-to-down left or Left-to-down right, depending on the 
number of pages selected.

• By clicking the Borders checkbox, a frame is placed around the individual page images on the 
single sheet of paper.

c Click the Poster radio button to expand the contents of a single page onto more than one sheet of 
paper. The final output consists of your selected poster image distributed among the number of 
pages defined:
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• The Poster drop-down menu is displayed where you can select 2x1, 2x2, 3x3 or 4x4 to define 
on how many sheets to fit the selected poster image.

• By clicking the Print Borders checkbox, the printer will automatically place a frame around 
each individual image that your poster is composed of. An indication of the position of the 
image in the poster is also provided.

d To restore the different settings to their factory default values, click the Default button.
e On the bottom of the screen:

• Click the OK button to confirm the settings made and exit.
• Click the Cancel button to exit without saving the changes made.
• Click the ? button for information on the Layout tab.

5 Click the Ink Levels tab to see the estimated amount of ink still available in the ink cartridge. This is 
important information to consider before launching a lengthy print job.
a On the Ink Levels tab there is also the Launch Toolbox button, a direct link to the Toolbox 

Maintenance screen that provides a user interface for the maintenance and troubleshooting of your 
printer. See "The Toolbox" for more information.

b On the bottom of the Ink Levels tab:
• Click on the OK or Cancel button to exit.
• Click on the ? button for information on the Ink Levels tab.

6 Click the OK button in the Print dialogue box to start printing.

Printing with the Toolbox Print Photos Tool

1 Right click your mouse button on the Olivetti icon on the Windows task bar and click MY_WAY 
Toolbox, or click Start > Programs or All Programs > Olivetti > MY_WAY Toolbox. The Toolbox is 
displayed.
note: In the Mac OS X environment, the Toolbox program can be launched by clicking the icon 
present on the desktop or by selecting it from the list of installed programs.

2 Click Print photos. The "My pictures" folder of your personal computer is opened by default if a 
digital camera is connected; if a memory card is inserted, the folder with the contents of the memory 
card is opened by default. 
note: The printer directly prints the picture files stored on the memory card and therefore do not 
remove the memory card from its slot while connection is in progress.

3 The pictures stored in the folder are displayed in thumbnails on the left of the dialogue box; the first 
photo of the folder, or the photo select, is displayed in a larger view on the right of the screen. You can 
now select what to do:
a Click the Add All button to add all the photos in the folder to your selection of photos to print.
b Select the individual photos to print by clicking directly on the photo wanted. Define the number of 

copies that you want to print of the photo selected by clicking on the plus (+) and minus (-) boxes 
that appear on the selected photo. You can also select the number of copies by clicking on the copy 
selection arrows on the bottom of the screen. The box on the left upper part of the selected photo 
indicates the number of copies chosen. Use the box’s side scroll bar or arrow buttons to move up 
and down through the selection of photos available.
note: To remove all the photos from your print selection, click the Clear Selection button. To 
remove single photo selections, click on the minus (-) box on the individual photos, or click the copy 
selection arrows on the bottom of the screen, to decrease the number of copies to zero. 

4 Click the Print button. The Print Photos dialogue box is displayed.
note: You can improve the quality of the photos by applying the correction filters that are available in 
this selection screen. To activate these filters, tick the selection box corresponding to the filter wanted; 
a preview of the correction is displayed.

5 Personalise your print settings:
a Paper setup: from the drop-down menu select the paper that you loaded and define its size.
b Quality: define the quality of your printed output. Select between Speed (highest print speed, 

lowest resolution), Normal (average print speed and resolution), High (low print speed, high 
resolution) and Photo Quality (lowest print speed but with the highest print resolution on photo 
paper).
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c Select Layout: choose the layout that you prefer by clicking on the graphical representation of one 
of the following options: Full Page, Two-in-One, Four-in-One and Index.
note: The Borderless layout is not available if Plain paper type is selected.
note: When the Two-in-One paper layout, if an 10 x 15 paper size is chosen, the printer will print 
two wallet-sized pictures. When a Four-in-One paper layout is selected, if an 10 x 15 paper size is 
chosen, the printer will print four passport sized pictures. When selecting an Index layout, all of the 
pictures will be bordered. When selecting an Index layout, all of the pictures will be bordered.

6 Click the Print button to start printing. 

TRANSFERRING FILES FROM A MEMORY CARD TO YOUR COMPUTER

1 Insert into the corresponding slot on the printer, the memory card containing the files to transfer. See 
"Inserting and Removing Memory Cards".

2 Right click your mouse button on the Olivetti icon on the Windows task bar and click MY_WAY 
Toolbox, or click Start > Programs or All Programs > Olivetti > MY_WAY Toolbox.
note: in the Mac OS X environment, the Toolbox program may be run by clicking on the icon present 
on the desktop or by selecting it from the list of installed programs.
The Toolbox is displayed.

3 Click the Memory Card File Transfer icon.
4 Click the Browse button and search for the folder on your computer in which to transfer the files.
5 Click the OK button once you have found the folder wanted.
6 Click the Transfer button to start the file transfer from the memory card to your computer.

note: To cancel the file transfer and return to the Toolbox’s main screen, click the Cancel button. 
For information, click Help.

SETTTING THE PARAMETERS TO IMPROVE PHOTO PRINT QUALITY

1 Open the Toolbox program to access the image quality improvement functions.
2 Select the Print photo to apply a correction filter.
3 With a click of the mouse, select the photo to be printed from the list on the screen in order to apply an 

image correction filter.
4 Apply the correction filter desired, clicking on its related selection box.

The available correction settings differ and depend on the results to be achieved.
It is possible, for example, to improve definition of details, to apply suitable contrast for the image and 
other effects.

5 Click the Print button to print the photo.
The number of copies to be printed can be defined before clicking the Print button.  
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CHECKING THE INK LEVEL

To know when the ink cartridge is running out of ink and needs replacing, check the ink level in the 
following ways:

1 By viewing the ink level indicator on the Ink Levels tab of your print driver’s Preferences or Properties 
dialogue box, as follows:
a With the document file open in the application that you are using, click File > Print. The Print 

dialogue box is displayed.
b Click Preferences or Properties, depending on your operating system. The printer driver user 

interface screen is displayed.
c Click the Ink Level tab. The ink capacity indicator shows the percentage of ink remaining in the 

cartridge. 
2 From the Toolbox, by viewing the ink level indicator on the bottom of the Toolbox’s main screen:

a Right click your mouse button on the Olivetti icon on the Windows task bar and click MY_WAY 
Toolbox, or click Start > Programs or All Programs > Olivetti > MY_WAY Toolbox. The Toolbox 
is displayed.

note: In the Mac OS X environment, the Toolbox program can be launched by clicking on the icon 
present on the desktop or by selecting it from the list of installed programs. The Toolbox is displayed.
b Click Solutions and Assistance.
c Click Select to choose New ink cartridge. The New ink cartridge dialogue box displayed includes 

the ink level indicator showing the amount of ink remaining in the cartridge. 
3 From pop-ups displayed by the Printer Status Monitor during a print job, that show the amount of ink 

remaining. See "The Printer Status Monitor" for more information.
4 From the Start menu:

Click Start > Programs or All programs > Olivetti > MY_WAY New ink cartridge. The Status 
Monitor is displayed.

5 Directly on the printer control panel:
When the ink indicator begins to flash, the ink level in the cartridge is getting low; when the indicator 
is on steady, the ink cartridge is almost out of ink.
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REPLACING THE INK CARTRIDGE

Before proceeding with the procedures indicated in this section, carefully read and follow the 
information provided in "Safety Instructions" at the beginning of this manual.
For information on how to purchase new ink cartridges from the manufacturer, consult the Toolbox’s 
Solutions and Assistance feature. To access the Toolbox, see “The Toolbox”. To guarantee the correct 
operation of your printer and top quality printing, it is essential to use only the manufacturer’s original 
ink cartridges.

1 Turn on the printer. 
2 Make sure that paper is loaded. See "Loading Paper".
3 Open the printer’s right outer door by pressing the upper centre part of the door to release it, then pull 

open the printer’s right inner door. The ink cartridge carrier moves to its loading position at the far 
right-hand side of the carriage.

4 With your index finger, pull and rotate downward the top edge of the ink cartridge and remove it from 
the carrier.

5 If you are installing a new ink cartridge, remove the cartridge from its box and then gently remove the 
protection tape that covers the ink nozzles. DO NOT TOUCH THE CONTACTS or the ink nozzles. Hold 
the ink cartridge by its sides.
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6 Hold the ink cartridge with its nozzles facing downward and its contacts facing the rear of the printer, 
then insert the cartridge into the carrier from the bottom nozzle side first and with a rotating motion.

7 Push the ink cartridge firmly until it clicks into place.

8 Close the printer’s inner door.

9 If a new cartridge is installed, the printer will automatically perform a cartridge recognition procedure 
which lasts about 1 minute. An ink cartridge alignment page will then be printed to indicate that the 
newly installed ink cartridge was automatically aligned. For information see "Aligning the Ink 
Cartridge".
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ALIGNING THE INK CARTRIDGE

The ink cartridge is automatically aligned by the printer whenever a new cartridge is installed.
However, you need to manually align the ink cartridge when the edges of the printed photos are still 
not clear, or when the lines still appear wavy, even after cleaning the ink cartridge nozzles. 
See “Aligning the Ink Cartridge From the Toolbox”.

Aligning the Ink Cartridge From the Toolbox

When the edges of the printed photos are still not clear, or when the lines still appear wavy, even after 
cleaning the ink cartridge nozzles:

1 Right click your mouse button on the Olivetti icon on the Windows task bar and click on MY_WAY
Toolbox, or click Start > Programs or All Programs > Olivetti > MY_WAY Toolbox. The Toolbox is 
displayed.
note: In the Mac OS X environment, the Toolbox program can be launched by clicking the icon 
present on the desktop or by selecting it from the list of installed programs. The Toolbox is displayed.

2 Click Solutions and Assistance and then select the "Print the alignment page" option.
3 Click the Select button and then click Print.
4 When the alignment page is printed, the ink cartridge has been aligned. Click Cancel to return to the 

previous Toolbox screen.
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CLEANING YOUR PRINTER

CAUTION: Do not clean the inside of your printer and do not use stain removers, acetone-based 
products, liquid or aerosol cleaners. Doing so could damage your printer case.

Cleaning the Printer Casing

1 Clean the printer casing by using a soft dry cloth or moistened in warm water to wipe dust, dirt or 
smears off the outer case of your printer only.

CLEANING THE INK CARTRIDGE NOZZLES

Clean the ink cartridge nozzles when:
• White or colour lines appear in your printouts.
• Colours fade, or do not print in parts or completely.
• The vertical lines of your printout are jagged.

To clean the ink cartridge nozzles:
1 Make sure paper is loaded in the printer. See "Loading Paper".
2 Right click your mouse button on the Olivetti icon on the Windows task bar and click on MY_WAY 

Toolbox, or click Start > Programs or All Programs > Olivetti > MY_WAY Toolbox. The Toolbox is 
displayed.
note: In the Mac OS X environment, the Toolbox program can be launched by clicking the icon 
present on the desktop or by selecting it from the list of installed programs. The Toolbox is displayed.

3 Click Solutions and Assistance.
4 Select the "Clean and Test Nozzles" option.
5 Click the Select button and then click Print. The printer automatically cleans the nozzles and prints a 

test page.
6 Check the quality of the printed output with the example displayed on the computer monitor. If you 

are not satisfied with the quality of the printed output, click the Clean again button to repeat the 
nozzle cleaning procedure.

7 When finished, click the Close button to return to the Toolbox main user interface screen.
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TROUBLESHOOTING

Problems During Printer Setup

Before reading this section:
1 Make sure the printer’s AC power supply unit is properly connected to the printer and to a 

working electrical outlet, or the car cigarette lighter DC adapter is properly connected, or the six 
rechargeable AA size 1.2 V Nickel Metal Hydride (NiMH) batteries, with a capacity of at least 2.2 to 2.5 
Ah each, are properly inserted and fully charged.

2 If you are using your printer with a personal computer, make sure that you have turned on both your 
printer and computer. 

3 Make sure the computer’s operating system is Windows 98 SE, ME, 2000 or XP, or MAC OS X 10.2 or 
higher.

Problem Possible Cause Corrective Action

Your printer does not turn on. • When the printer is 
powered from the mains 
through its CA power 
supply unit:
The power supply unit’s 
power cord is not properly 
attached to the printer and/
or not properly plugged into 
a working electrical outlet.

1 Unplug the power supply 
unit’s power cords from the 
printer and from the 
electrical outlet and then 
plug them back in.

2 If the ON/OFF button is not 
illuminated make sure that 
the electrical outlet is 
working by attaching 
another appliance that you 
know works into it and then 
turn on the appliance.

• When the printer is 
powered from the car 
battery through the car 
lighter DC adapter:
The car lighter DC adapter is 
not properly attached to the 
printer and/or to a working 
car cigarette lighter socket.

1 Unplug the cigarette lighter 
adapter from the printer and 
from the car socket and then 
plug it back in.

2 Make sure that the car 
cigarette lighter socket is
working by attaching 
another device (such as a 
mobile phone) that you 
know works into it and then 
turn on the device.

• When the printer is 
powered by rechargeable 
batteries:
Six rechargeable AA size 1.2 
V Nickel Metal Hydride 
(NiMH) batteries, with a 
capacity of at least 2.2 to 2.5 
Ah each, are not inserted, or 
the batteries are not fully 
charged.

• Remove and reinsert the 
batteries correctly, or 
recharge the batteries.

You insert the “Installation”CD-
ROM into your computer CD 
drive and the installation 
program does not start 
automatically. 

• An operating system 
incompatible with the CD-
ROM software may be 
running on the personal 
computer.

• Make sure the personal 
computer is running 
Windows 98 SE, ME, 2000 or 
XP, or MAC OS X 10.2 or 
higher.
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• The auto-run feature is 
disabled.

• Your personal computer 
cannot find setup.exe on the 
CD-ROM.

• The CD-ROM will not start.

• In Windows:
1 Remove and replace the 

“Installation” CD-ROM in the 
CD drive with the written 
label upwards.

2 Select Start > Run and then 
click Browse.

3 Find the CD-ROM drive 
identifier and click Open.

4 Select Setup and click Open.
The file setup.exe is displayed 
in the dialogue box.

5 Click OK and then follow the 
instructions displayed.

• In Macintosh:
1 Power on the computer and 

insert the "Installation" 
CD-ROM in the drive.

2 Double click the CD-ROM 
icon displayed to start 
installing the software and 
follow the instructions 
displayed.

Your printer’s name is not 
available when you select File > 
Print from an application. The 
printer is not shown in the 
Printer folder on the Control 
Panel.

• The printer driver was not 
installed correctly

1 Close all applications 
currently open.

2 Reinstall the printer software 
as instructed by the Setup 
Diagram or as indicated in 
the step above.

When connecting the printer to 
the computer with the USB 
cable, the Plug and Play wizard 
did not terminate.

• The computer did not find 
the printer driver.

1 Remove the “Installation” 
CD-ROM from the drive and 
re-boot the computer.

2 Place the “Installation” CD-
ROM in the drive with the 
written label facing upwards.

3 Reinstall the printer software 
as instructed in the Setup 
Diagram or as indicated in 
the step above.

When connecting your printer to 
the computer with the USB 
cable, the New Hardware Wizard 
is not displayed on the 
computer’s monitor.

• The computer is running an 
incompatible operating 
system.

• Make sure the computer is 
running Windows 98 SE, ME, 
2000 or XP, or MAC OS X 
10.2 or higher.

• The USB cable may not be 
properly connected between 
the printer and computer.

1 Turn off your printer and 
computer, then unplug the 
USB cable from these two 
devices.

2 Reattach the USB cable to 
the two devices by following 
the instructions in the Setup 
Diagram. Turn on the printer 
first followed by the 
computer.

Problem Possible Cause Corrective Action
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• The computer may not be 
enabled for USB operation.

• In Windows:
1 Click Start > Settings > 

Control Panel.
2 Double click the System

icon.
3 Click the Device Manager

or Hardware tab, then click 
the Device Manager
button.

4 Click the Plus (+) sign next to 
the USB (Universal Serial Bus) 
Controller option.
– If USB host controller and 

USB root hub are present, 
the USB is enabled.

– If they are not present, 
read your computer 
manual for information 
on how to enable a USB 
connection.

• In Macintosh:
– From the control panel, 

check the characteristics 
of the system and that 
there is a USB connection 
up and running.

– Reinstall the USB drivers 
for Macintosh by 
consulting the 
documentation provided 
by the system 
manufacturer.

Problem Possible Cause Corrective Action
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Problems When Powering On the Printer

Printing Problems

Problem Possible Cause Corrective Action

The printer does not turn on 
when you press the Power ON/
OFF button on the control panel.

• Refer to the section 
“Problems During Printer 
Setup”

Refer to the section “Problems 
During Printer Setup”

Individual indicators on the 
control panel come on.

• Specific printer error as 
signalled by the indicator.

• Check the corrective action 
for the corresponding 
indicator that is explained in 
"Meaning of the Indicators 
on the Control Panel".

Problem Possible Cause Corrective Action

Your printer does not print when 
you click on the Print icon on the 
task bar of the application you 
are using.

• Your printer is not set as the 
default printer.

• In Windows:
1 Click Start > Settings > 

Printers.
2 Right-click your printer’s icon 

and select Set as Default.
• In Macintosh:
1 Reinstall the software 

provided with the printer and 
check the print and spooler 
settings of the Mac OS X 
system.

• Your printer is not properly 
connected to the computer.

1 Turn off your printer and 
computer, and then unplug 
the USB cable from these 
two devices.

2 Reattach the USB cable, then 
turn on the printer first 
followed by your computer.

The printing stops in the middle 
of a print job.

• The paper is jammed. 1 Clear the paper jam. See 
"Clearing Paper Jams".

2 Press the Cancel button to 
reset the error condition. The 
print job continues from the 
next page.

Horizontal streaks are printed. • The ink cartridge is dirty. • Clean the ink cartridge. See 
"Cleaning the Ink Cartridge 
Nozzles".

The printed characters are not 
properly defined.

• The ink cartridge is no longer 
aligned.

• Align the ink cartridge from 
your computer. See 
"Aligning the Ink Cartridge 
From the Toolbox".
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Meaning of the Indicators on the Control Panel

CLEARING PAPER JAMS

1 Pull open the printer’s right inner door.
2 Firmly grasp the jammed paper and gently pull it out from where it jammed. If the paper tears, make 

sure you remove all the torn pieces from the printer.
3 Close the printer’s right inner door.
4 Press the Cancel button on the control panel to clear the error condition.

note: If the paper jam occurred when printing without a computer, the print job will continue from the 
next page.
If the jam occurred when using a computer, the pop-up screen displayed allows you to either continue 
to print from the next page or to cancel the print job. 

Problem Possible Cause Corrective Action

The out of ink icon on the 
control panel is flashing.

• The ink cartridge is almost 
out of ink.

• You can continue to print 
until the icon is illuminated.

The out of ink icon on the 
control panel is illuminated.

• The ink cartridge is out of 
ink.

• Replace the ink cartridge. For 
information, see "Replacing 
the Ink Cartridge".

The paper error icon on the 
control panel is illuminated.

• You launched a print job and 
there is no paper loaded in 
the printer.

• Load paper. For information 
see "Loading Paper".

• The size of the paper that is 
loaded does not match the 
paper size that you selected 
from the Toolbox application 
or from the PictBridge-
compliant digital camera 
connected to the printer.

• Load the correct paper. For 
information see "Loading 
Paper".

• A paper jam has occurred. • Clear the paper jam. For 
information see "Clearing 
Paper Jams".
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GENERAL SPECIFICATIONS

General Specifications

Display 2.4" colour Liquid Crystal Display for photo 
preview and selection.

Dimensions and weight • Height: 90 mm
• Width: 220 mm
• Depth: 162 mm
• Weight: 1.6 Kg

Power source • External AC power supply unit with an input 
voltage of 100-240 Vac 1.2 A max. and an 
output voltage of 12 to 16 Vdc, 2A.

• Car cigarette lighter DC adapter plugged into a 
12V automobile cigarette lighter.

• Six rechargeable AA size 1.2 V Nickel Metal 
Hydride (NiMH) batteries with a capacity of at 
least 2.2 Ah each. 

Power consumption Maximum 35 W

Connectivity • High-speed USB 2.0 interface for the 
connection of a personal computer.

• PictBridge-compliant USB 1.1 for the 
connection of a digital camera.

Wireless Interface • Bluetooth 1.2 Class 2 for connection to 
compatible PCs and mobile phones.

Memory card interfaces Can accept the following memory card types:
• Compact Flash I, II
• Microdrive
• SmartMedia
• SecureDigital (Mini SD adaptor sold separately)
• MultiMedia card
• Duo, Pro, Magic Gate Memory Sticks 

(MS Pro adaptor sold separately)
• xD-Picture card
• Up to 2 GB memory cards.
All the images saved on memory cards can be 
displayed, selected and printed or saved on the 
computer also using the "Toolbox" program.

Paper feed • Automatic sheet feeder from a paper cassette 
capable of holding up to 20 sheets of 280 gr/
m2 photo paper

• Manual feed of a single sheet of plain A4 paper 
folded vertically in the middle

Temperature ranges • Operating: 15 °C to 35 °C
• Storage: -5 °C to +45 °C (without the ink 

cartridge) 
• Transportation: -15 °C to +55 °C

Humidity ranges • Operating: 15% to 85%, non-condensing
• Storage: 15% to 85%, non-condensing
• Transportation: 5% to 95%, non-condensing
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PRINTER SPECIFICATIONS

PAPER SPECIFICATIONS

Supported Paper Types

Software and documentation • Printer driver (WIN/MAC)
• Toolbox (WIN/MAC)
• User Documentation (WIN/MAC)
• Additional software (WIN)

Minimum system requirements for the connected 
personal computer

Operating system: 
• Microsoft Windows 98 SE, ME, Pentium II 500 

MHz, 128 MB RAM, 150 MB HDU
• Microsoft Windows 2000, Pentium III 650 MHz, 

128 MB RAM, 200MB HDU
• Microsoft Windows XP, Pentium III 650 MHz, 

256 MB RAM, 200MB HDU
• MAC OSX 10.2 Power PC G4, 256 MB RAM, 

500 MB HDU

Supported files type DCF, JPEG baseline, Exif, DPOF

Printer Specifications

Printing technology Bubble ink-jet

Printing system One, disposable 3-colour ink cartridge

Print resolution • 1200 x 1200 dpi
• 4800 x 1200 dpi
• 1200 x 600 dpi (text-based documents only 

received from a computer)

Print speeds • 1 page/90 sec, very high quality resolution on 
A6 size photo paper

• 1 page/60 sec, high quality resolution on A6  
size plain paper

Margins Borderless on photo, coated and glossy paper, and 
on plain A4 paper folded vertically in the middle.

General Specifications

Paper type Paper weight Maximum feed capacity

10x15 / 4"x6" and A6 Coated 
paper 

100 to 170 g/m2 20 sheets

10x15 / 4"x6" and A6 Glossy 
paper 

160 to 180 g/m2 20 sheets

10x15 / 4"x6" and A6 Cards 
paper 

130 to 280 g/m2 20 sheets

10x15 / 4"x6" and A6 Photo 
paper 

170 to 280 g/m2 20 sheets

Dual A6 (A4 Plain paper sheet 
folded vertically in the middle)

80 to 90 g/m2 Single sheet manual feed
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Supported Paper Formats and Sizes

note: All of the above paper sizes are automatically detected by the printer.

Format Size
4x6" cards 102 x 152 mm

A6 cards 105 x 148.5 mm

Dual A6 (Folded A4) 105 x 297 mm

10 x 15 cards 105 x 150 mm
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